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About PDF to Flash Magazine Pro 

If you want or need to produce more elegant 

digital magazines, PDF to Flash Magazine 

Professional is your lucky software, which provides 

you GUI, Batch Convert and Command Line 

professing modes. You are enabled to insert Web 

Link, Page Link, and Email Link into pages, embed 

different images, music files, movie files, and flash 

SWF into any book page as you want. More 

importantly, output flipping-magazines can be 

viewed in many browsers, no matter on PC, Mac or 

mobile devices (iPhone, iPad, Android, etc.) 

 

 

 

 

 

 

Note: This product is distributed on a "Try before-you-buy" 

basis. All features described in this documentation are 

enabled. The registered version doesn't insert a watermark 

in your generated page-flipping eBooks. 
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Main features and advantages  

1. More Easy and Quickly 

To meet the needs of today’s fast-paced, PDF to flash Magazine Pro enables 
you to easy and fast converter PDF files to Flash magazines, do not need 
any programming tricks. Only three steps to complete your E-Magazine 
building work, Import PDF, Edit Pages, Convert to Flipping Book, a stunning 
flipping-page digital magazine will be done. Amazing software, isn’t it? 

2. More Professional 

Based on 3 years' research and development, more suitable and 
professional product PDF to Flash Magazine Pro published. Compare to 
original standard version and many other flipping book build tools, PDF to 
Flash Magazine Professional version develops more powerful and excellent 
features to create amazing Flash publications, Command Line, design 
toolbars with your own icons, insert multi-media into pages, moreover, you 
can build your wanted features in books with using Javascript function 
directly. 

3. More Powerful 

PDF to Flash Magazine Pro have the powerful function that you never 
thought. You are enabled to insert Web Link, Page Link, and Email Link into 
pages, embed different images, music files, movie files, and flash SWF into 
any book page as you want. More importantly, output flipping-magazines 
can be viewed in many browsers, no matter PC, Mac or mobile devices 
(iPhone, iPad, Android, etc.) 

4. More Convenient 

Share Ebooks created by PDF to Flash to Magazine Pro is very convenient, 
either email share or social share could be used as readers want, very 
convenient to share your magazine with more people in the internet. 
Besides sharing feature, the program provides free templates and themes, 
you can choose your favorite one to create Flash magazine more 
conveniently. 

5. More Worthy  

Wish using PDF to Flash Magazine Professional, you could make it to be a 
PDF converter, a good presentation builder, a moviemaker, or even a Flash 
MTV integrator. Besides Flash Player needed, PDF to Flash Magazine Pro is 
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independent software without any other third-party program required. You 
can save a larger amount of money if choose the Professional program. 
Compare with other major competitors, it's cheaper 28%, and with 
absolutely no loss of service or quality. 

6. More Efficient 

In PDF to Flash Magazine, more efficient options help you to make your 
books more powerful and effective. Full-Text Search to fast location the 
content, Bookmark and Thumbnail navigations, Zoom in, Zoom out, Full 
Screen and Minime presentation modes, Help image or flash show to 
provide more useful info, etc. 

7. More Transparency 

We can assure you there is no hidden cost or charge, it is 100% 
transparency. We means what we say, the price is always fine and simple. 
All prices and terms are displayed clearly and are readily available on our 
website. Once purchase, don't need other extra fee. 

8. More Facilities Support 

While using PDF to Flash Magazine pro, you can get many related facilities 
as support. Graphical, easy to use handbooks, wizards and video tutorials 
guide you effortlessly through creating an great magazine. Besides, you can 
send questions to our support center at any time: 
support@emagmaker.com . 

9. More Confidence 

Have no confidence to buy things on the Internet for bad purchasing 
experience? You can trust us, besides trial version totally free, we also offer 
30 Day Money Guarantee. If you are not satisfied with the software in 
future, you can get you full money back by sending us your request and 
Order detail. 

10. More humanistic 

Encounter problems while using PDF to Flash Magazine Pro, or want to 
customize new features, you can contact our customer service team at any 
time, 24 hours a day, 7 days a week. We are here to help you every step of 
the way and Email support is our main support method. 
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Quick Start 

1. Launch the application via the desktop shortcut ; 

2. Click the "Import PDF" icon  to enter into Import PDF interface; 

3. Click icon to choose PDF file from your computer; 

4. Click icon to enter into template setting interface; 

5. Define parameters for eBooks, such as Book, Tool Bar, Bookmarks, and 

then click the "Apply Change" icon ; 

6. Click "Convert to Flipping Book" icon to enter into Output 

interface; 

7. Choose Output Type from HTML, ZIP and EXE, here take 

as example; 

8. Click to set Output Folder as "C:\flipbook", input File Name 

as "demo"; 

9. At last, click icon to output created page-flipping eBook. 

 
You can open the "flipbook" folder in "C:", there are three files in this folder: 
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Open the "demo.html" file to view your created page-flipping book via Web Browser, 

such as Internet Explorer, Google Chrome, Firefox, etc. 

 

 

Interfaces 

There are some main interfaces you will see while using PDF to Flash 

Magazine Pro as below shows: Application Options, Import PDF, 

Template Settings, Edit Pages, Language Option, Output, Batch Convert 

and Command Line. You can enter into each page to get clear 

instructions for every detail option. 

 

I. Application Options Interface 

1. Render Engine Option 
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PDF to Flash Magazine Pro provides 3 different render engines for you to create 

higher quality page-flipping eBooks, click "Options->Application Options" to enter 

into "Render Engine" interface: 

 

  
 

SWF: Much legible characters, smaller output size 

GPL Ghostscript: Higher color transfer quality 

Inner Library: Faster convert speed 

(Change option when PDF imported failed) 

 

2. Create Mobile Version Option 

(1) Pages Quality and Size 

Five types of "Pages Quality And Size" for mobile version eBooks: 

 

 

(2) Mobile Template 

The current version provides two mobile template modes for you to use: Slide and 

Single Page Flip. The later one adds page-flipping effect on the pages while viewing 

in mobiles. 
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II. Import PDF Interface 

 

1. Source PDF File 

 Click this icon to open the PDF file you want to convert; 

 View content of added PDF file to clarify before converting. 

 

2. The Page Ranges to Import 

 Convert all pages to page-flipping eBook; 

Convert defined range page; 

 Just preview effect on first 10 pages. 

 

3. Watermark 

 Add image or text watermark to flipping pages. 

Check this option first to choose default stamps or add new ones: 
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4. Page Quality 

There are five types of "Quality And Size": 

 

 

5. Other Options 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

Check this option to make landscape page in PDF file to be presented as 

two-page spread in output flipbook. 

 

At last, click  icon to enter into template setting interface. 
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III. Template Settings Interface 

 
PDF to Flash Magazine Pro provides four different templates at present: Classical, Float, Neat 

and Spread. Each template contains some unique settings, the below instructions will show 

you details about the default three templates. 

 

The design setting interface contains below main parts: 

Choose Template, Tool Bars Settings, Flash Display Settings and Flash Control Settings. 

 

1. Choose Template 

 

Click icon to select templates from below interface: 
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Other four templates are new published ones which you can purchase from our website. 

 Click this icon is to save current settings as a TXT file for later uses; 

 Click this icon is to import stored setting file at once. 

 

2. Tool Bar Settings 

 
 

(1) Title Bar (set logo in Float and Neat templates) 

 

Customize book title and logo for showing on the top of your flipbook. You are enabled to 

set the book title as HTML format text. For example: <a href='http://www.Emagmaker.com' 

target='_blank'>EMAGMAKER.COM</a> | <font color='#ff0000' size='14'>Red Color</font> 
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(2) Buttons Bar 

 

i. Home Button 

You can add a home button  to help reader to click and go to your website directly: 

 
 

ii. About Button 

Add About button  to show the author, contact, book, company info: 

 

Click "…" to enter into "About & Contact" edit interface: 

 

After clicking the About button, you will view the About window by clicking the button. 
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iii. Full Screen Button 

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen 

Button" option:  

Then you can click icon  to view flipbook in Full Screen, click icon  or "Esc" 

button to exit from the Full Screen. 

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, 

you can set "No" in "Full Screen without Tool Bar" (just in Classical Template): 

 
 

iv. Help Config 

 

To show tips about viewing flipbook, you can set "Show" in "Help Button" option, and you 

can define Help Content manually by inserting "Help Content File (image or SWF)", also 

enable to define the Width and Height of the Help image or swf. If you set "Book->Retain the 

book to center->No", you can set "Show Help At First->Show" to display the Help Panel with 

the Book as below: 

 

You can also click the button  to view the same Help page in pop-up window. 

v. Print Config 

 

Choose "Yes" in "Print Enable", then click icon  to set print page range as below: 



Professional convert PDF to Page-Flipping eBook Utility 
 

User Document 

Copyright 2010 by Emagmaker.com 
- 13 - 

 

 

You can also click "Print Watermark File->…" button to choose image or SWF file from your 

computer as watermark on printed out pages. 

 

vi. Download Setting 

  

If you want your flipbook readers to download the PDF file or the flipbook directly from your 

website, select "Yes" in "Download Enable" option, then input the Download URL directly, 

you can use absolute path like 

"http://www.flipbuilder.com/flip-pdf/example/files/download/Demo.pdf" or relative path 

like "/files/download/Demo.pdf" (make sure you have uploaded the PDF to the same path). 

Then readers can click the icon  to download your uploaded PDF file directly. 

 

vii. Sound 

 

If you want to add background sound to your flipbook, such as a song or other audio file, set 

"Enable Sound->Enable", then click " " icon to choose "Sound File" from your computer, 

then set "Sound Loops", "-1" stands for playing the sound file all the time while viewing 

flipbook, other value (N>0) stands for the times of playing the sound file. 
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viii. Zoom Config 

 

To Enable Zoon In functionality, choose ''Yes" in "Zoon in enable", then set "Zoom Scale", the 

value is the times between zoomed page size and the current page size. 

 

In Float template, you don't need to set Zoom Scale, you can adjust more conveniently by 

the zoom in tool like this: . You can also set "Scroll 

with mouse->Yes" to scroll zoom in page while moving mouse. 

 

ix. Search 

 

Select "Show" in "Search Button" (make sure you have check "Enable Search" option in 

"Import PDF" interface), then define "Search Highlight Color", after clicking "Search" icon 

, you will see a popup box to input search words, then click Enter or "Search" button, 

you will get the below searching result: 
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x. Share 

 

You can share via emails, or just through Facebook, Twitter, Google, etc.. 

a. Share Button 

If you want readers to share via Email, you can enable "Share" feature as below shows: 

 

When the viewers click the share button , they will enter into the Email interface with 

the link of your flipbook in the Email body. 

 

b. Social Share 

If you want your flipbook viewers to send the link to their friends or clients via Facebook, 

Twitter, Linkedin, Google, Yahoo and so on, you can add a Social Share button in your 

flipbook for readers to send out your flipbook link immediately: 

 

The readers just need to click the "Social Share" button , then the below window will pop 

up for them to choose share channel: 

 

 

xi. Auto Flip 

To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the 

Flip Interval (seconds of staying on each page); the value of "Play Count" stands for the times 

of auto playing the eBook, and "-1" stands for playing forever (after clicking the Auto Flip 

button , the flipbooks will be flipped by staying 3 seconds per page); if you want to 

auto start and flip the eBook after opening, just set "Auto flip when start up->Yes": 
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xii. Thumbnail Button 

 

Show Thumbnail Button (set "Enable") to view page thumbnails of your book, or you can 

Disable it to hide the button. 

 

xiii. Single Page 

 

If your book contains landscape pages, or the page content is different to read for the font is too 

small, you can set "Single Page->Enable" to enable readers to click "Single Page" icon  to 

view pages one after another, then click "Double Page" icon  to back to the normal book 

reading mode. 

 

(3) Tool Bar on Top (only in Float template) 

If you want to place the toolbar in Float templates on the top of the flash eBook, you can set 

"Tool Bar on Top" as "True": 

 

 

(4) Add Icons Settings 

If you want to add some other kinds of buttons which the program doesn't provide, you can click 

"Add Icons Settings->…" to enter into "Icons Settings" interface to add new icons on tool bar: 
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You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. After your "Apply Change", the new added icon will show in the toolbar. (More 

details about Call Javascript function will be introduced in the part of "Edit Page->Add Link".) 

 

(5) Button Icons 

Define settings for the icons of the buttons: 

 

i. Icon Color  

 

 

ii. Icon File 

Select the Tool Bar Button to replace with your own icon.  

 

More details please view here:  

http://www.flipbuilder.com/support/how-to-replace-icons-on-flash-toolbar.htm 
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3. Flash Display Settings 

 

(1) Retain the book to center 

 
If you select “No” in this option, the eBook will be shown on the right-side. This setting is for 

embedding special background image, such as advertisement or company log. 

(2) Language 

  

You can set language for showing tools or tips in your created flipbook, and here is the 

specialized instruction page for setting the "Language Option". 

(3) Font 

 

If you want to change fonts of toolbar buttons, flash windows even bookmarks or search 

result panel, you can set font types and colors in Font Panel.  

(4) Initial Show (set in Float/ Spread templates) 

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just 

select "Bookmark" or "Thumbnails" in this option: 

For Example, select "Thumbnails":  

Then you will get flipbook shown with below initial interface: 
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(5) Background Config 

i. Background Color:  

 

Define background for your flipbook with gradient color or pure color (the same color for 

"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle between the two 

colors. 

 

ii. Background Image (set in Classical and Spread templates): 

 
Click the icon " " to choose background image from your computer, and there are 11 kinds 

of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, 

Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.  
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iii. Background Image (set in Float template): 

 

The Float template enables you to add two background images: Outer Image and Inner 

Image. You can make Inner background image to show special information, such as 

advertisement or company logo, etc. There are also 11 kinds of "Image Position" for you to 

choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center, Middle 

Right, Bottom Left, Bottom Center and Bottom Right 

 

(6) Flash Window Color 

 

This color will be applied on all flash windows, such as the book window, "Help" window, 

"Print" window and so on. 

 

(7) Page Background Color 

 

When load pages, or if the page number of your PDF file is odd, then the page (the last page) 

will show with the "Page Background Color". 
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(8) Book Proportions 

 

Please note that the values are not fixed in pixels or inches, they just represent a ratio for 

"Page Width: Page Height", and the book size will be changed depend on your Explorer 

Window Size. 

 

(9) Book Margins 

i. Book Margin (set in Classical Template): 

 
"Book Margin" refers to the distance between the book and the toolbar. 

 

ii. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template): 
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(10) Page Shadow 

 
The value also takes the value of Book Proportions as reference, and the value interval of 

"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow color. 

 

(11) Hide Book Frame Bar 

 

If don’t want to show the book frame bar, choose “Yes” in this option. 

 

(12) Right to Left 

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in 

"Right to Left" option: 

 

 

(13) Hard Cover 

If you want create hard cover effect (a book bound with rigid protective covers) for your 

flipbook, choose "Yes" in "Hard Cover" option: 
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(14) Flipping time 

Sets page flipping time in seconds according to your 

needs. (Recommended second value is 0.6) 

 

(15) Page Number 

If you don't want to count in the cover page, table of contents pages into the actual page 

numbers, you can set "Start Page Numbering (Roman)" and "Start Page Numbering (Arabic)". 

For example, the first 3 pages are Table of Content pages with Roman page numbers, and 

set Arabic page numbers from page 4, then you will get page number box like below: 

 
 

(16) Minime Style 

If you want to present Page-flipping eBook pages directly without showing toolbar, especially 

when you want to embed eBook into a small area in existing webpages, then you can use this 

"Minime Style": 
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The Minime Style will trigger when the Width or Height of the Flash Container is less than the 

defined value. You can also always show the page-flipping eBook in Minime Style with adding a 

parameter to your URL like this: www.yourdomain.com/index.html?alwaysMinimeStyle=true . 

 

4. Flash Control Settings 

 

(1). Security Settings 

 

If you want to protect your flash books with passwords, you can click "…" icon to enter into 

"Flash Security Config" interface: 

 

http://www.yourdomain.com/index.html?alwaysMinimeStyle=true
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Select "Security Type->Single Password", and input passwords into the box (there is no 

restriction on password format at present). You can also set "Protect Page Range" as "All 

Pages" or the latter pages after a defined page number. (Tips: The program utilize RC4 

algorithm to protect eBook pages, the eBook content pages will show nothing without 

permission.) 

 

(2). Links 

 

If you have check "Import links" option in "Import PDF" interface, or add links in "Edit Page" 

interface, then you can define settings here, choose "Mouse over color", "Link alpha" (refers 

to the link area opacity, value interval: 0~1, "0" stands for the area is totally transparent), 

and "Open Window->Blank/ Self". The links also can be clicked after zooming by setting 

"Enable after Zooming in->Enable". 

 

(3). Google Analytics  

 
In the HTML output format, you can add statistics by using google analytics. You can get 

more information about Google Analytics ID from http://www.google.com/analytics/ . 

 

 

Besides, Export Theme 

 

If you want to save the current template settings as your own style template for later uses, 

you can click "File->Export current settings as Theme" button to storing all current template 

settings, include the background images, margin values, toolbar buttons and so on. 

Then when you want to use later, just click "File->Import Themes", the theme will be added 

to the templates selecting interface. 

 

http://www.google.com/analytics/
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IV. Edit Pages 

Now you can use PDF to Flash Magazine Pro to edit imported pages directly, no matter you want 

to add link, video, sound or image file.  

Just click "Edit Pages" button  to enter into the editing interface: 

 

You can insert links, images, sound, movies even buttons with calling functions to the pages. 

 

1. Add Link 
 

Click the icon  and then draw a link box on the area you want to add link, then define 

properties in below panel: 
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You can define the link action as "Go to page", or open an online webpage, or even "Call 

Javascript function" to carry out your wanted interactive functionalities via defining Javascript 

function yourself.. For example, you can show a pop-up light box while readers clicking some 

image on page, or pop-up a questionnaire or other Web Form by clicking some text. Just make 

sure the parameter you set in "Function" can be called in from HTML page. 

 

Example: Check "Call Javascript function" as action type, then input Function as 

"testLightBox("Hello, this is a test"): 

 

 

And then make sure the Javascript wrote into the index.html page as below image shows (the 

same as you set in "Link Function"): 
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2. Add Movie 

 

Click icon  and then draw a box like below on the page you want to insert FLV movie: 

 
Then you can select and edit the movie in below panel (define video player skin color, play and 

stop movie actions, etc.): 

  

 

3. Add Image 

 

Click the icon  to draw image box and then select image (.jpg, .png, .bmp), set Action 

Options (the same as Link Action Options): 
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4. Add Sound 

 

Click the icon  to draw sound box and then select sound file, set other options: 

 
 

5. Add Flash 
 

Click icon  to insert SWF flash into your defined area of flipbook page: 

 
 

6. Add Button 
 

Click icon  to draw an area for inserting your image or SWF button file with calling actions. 

The actions contain "Go to page", "Open a link", "Call Javascript function" and "Open Flash 

Window". The before three actions are the same with the actions in "Add Link", the "Open Flash 

Window" can help you to play SWF Flash or FLV Video in the pop-up window: 
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7. Add You Tube Video 

Click the icon and then draw a box on the page to insert You Tube video into pages directly. 

You just need to define the video ID directly. For example the video link is: 

http://www.youtube.com/watch?v=xKA6WIqjB7c, then the video ID is " xKA6WIqjB7c".  

 

 

8. Add Printable Area 
If you want readers can click on some area of your book to print the area directly, such as 

coupons which can be used to buy your presented goods, you can add a "Printable Area" on 

pages by clicking the icon , and then draw the area on the pages, set title and description: 
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9. Copy and Paste  
If you want to add same links, images, videos, audios to different pages, you don't have to repeat 

the "Link/Image/Video/Audio added" operations once and once again, just select the link object, 

click the copy button and then go to the other page to click the paste button directly. 

 

10. Apply All 
If you want to use the same link, video, audio, image or button on all pages (or all odd, even 

pages, or your customized pages), you can select the object and then click the Apply All button

, then define the apply page range in pop-up window like below: 

 
 

After adding links, flash, movie or sounds, you can click the icon  to save the settings and 

back to the template setting interface. 
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I. Language Options Interface 

Click "Option->Flash Language", you will enter into the Language Settings interface as below 

shows: 

 

Panel Description: 

As the tips explaining, the "Labeled" column lists the buttons and instructions on Flash books 

in defined language, and the program provides you five different languages for you to use: 

English, Chinese Arabic, French and Greek.   

 

You can also add other language for your own uses: 

 

1. Click the button  and define name for the new language: 

 
Click "OK" to save the new language in the list; 
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, 

then click "Save And Edit Next": 

 
 

 

3. At last, you can get all Labels translated into your new language as the images shows: 

 

You can delete unwanted language:  

Or save your edited new language file as XML or TXT file:  

Load language file saving before for current using:  

 

 

After setting template and language, click  icon to 

apply the settings. 
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II. Output Interface 

 

 

Output types: 

 

1. HTML 

 

This output type is for uploading created page-flipping ebook onto websites: 

 

You can define HTML Title and other properties by clicking "Advanced" button:  

 

  
 

Set Keywords, Description or even Script in the below interface: 
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2. ZIP 

 
 

This output type is for compressing the created files into an integral ZIP package which can 

be sending out as attachment directly. You can also define HTML Advanced Settings by 

clicking "Advanced" icon:  

 

Your recipients just need to uncompress the ZIP file and then they can view the HTML 

flipbook instantly: 

 

 

3. EXE 

 

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:  

 
You can also define Icon and Opening Window Size in Advanced Settings: 
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4. APP 

 

If you want to make executable application to run on Mac devices, you can output as 

"*.app" format. 

 

5. Mobile Version 

 
You can even output Mobile Version while choosing HTML or ZIP format at the same time. 

 

After creating mobile versions, you just need to output all files online (including HTML, SWF, 

"files" and "mobile" folders), then you can visit the flipbook page through your mobile 

browser.  

 

6. Burn to CD 

 

 
After choosing output type, then check the option "Burn to CD", set "CD Writer", define 

"Disc title".  

 

How to make created eBooks available for others online, more details this support page: 

http://flipbuilder.com/support/how-can-i-share-my-created-ebook-online.html . 

 

At last click button to output flipbook in your defined type. 
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III. Batch Convert Interface 

 

1. Add PDF Documents 

Click this icon to add PDF files from computer; 

 Click this icon to add all PDF files in the folder (include sub-folders). 

 

You can also remove some unwanted PDF, move up/ down files, or clear all documents.  

 

 

2. Settings 

 

(1). Output Settings 

  i. Choose Output Type 

 

  ii. Choose Output Path 
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You can also define output name pattern with FileName, Title, Subject and so on: 

 
 

And after defining the File Name, you can preview the result example below: 

 

 

  iii. Define Output Option 

 

Click "Advanced" icon to define Keywords, Description for HTML flipbooks, or define Icon, 

Window Size for EXE flipbooks: 

 

 
 

  iv. Merge All PDF Files to One Flip Book 

 

(2). PDF Settings 

  i. Page Range 

 

You can convert "All pages" or just "Custom range"; 
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  ii. Watermark 

 
Click "Set Watermark" icon to enter into "Watermark" interface: 

 

Check "Applying Watermark" option, then you can choose default stamps, Edit them, or Add 

Text Watermark, Add Image Watermark, Delete, Move Down/ Up. 

  iii. Page Quality 

 

Choose quality and size type from listed five kinds. 

  iv. Other Options 

If your PDF file contains bookmarks, check this option to use in output 

page-flipping eBook; 

If your PDF file has links, check this to enable in flipbook; 

Check this option to enable search functionality in created flipbook. 

 

At last, click  icon to batch convert listed files together. 
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IV. Use PDF to Flash Magazine Pro in Command Line 

You can also use PDF to Flash Magazine Pro in Command Line. 

 

PDF to Flash Magazine Professional Command Line Usage: 

 

 PTCMD.exe [Options] 

 

 -f<PDF File>           The source PDF file. 

 

 -o<output folder>      Specify the folder for the output files. 

 

 -t[html|zip|exe]       Output type. Default is html. 

 

 -n<OutputFileName>   Specify the name for the output file. 

 

 -c<caption>           Caption for HTML or EXE. 

 

 -s<Flash settings>      Value format is:<Template name>#[<Theme name>| 

                     <txt_settingfile path>]. 

                     <Template name> could be: Classic, Float, Spread. 

                     <Theme name> are list in the "Select a template" window, 

                     such as Blank,Blues,Nostalgia. 

                     <txt_settingfile path> is the file that you export 

                     with "Save the template settings" function 

 

 -r<page range>.       The page range that you want to import from PDF File. 

                     Range value string like:2-15,33,35-36,or All.(Default: All) 

 

 -q<import quality>     Count be 5,4,3,2,1.5 specify the higher quality larger file 

                     size;1 specifies lower quality smaller file size.(default:4) 

 

-R<GS|SWF|LIB>       Render engine options. (Default: GS, Ghostscript render                                                                           

engine)                                              

 

 -b<Y|N>             Import bookmark yes or no. (Default: Y) 

 

 -l<Y|N>              Import links yes or no. (Default: Y). 
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 -S<Y|N>             Enable searchable or not.(Default: Y, enable searchable) 

 

 -k<html key words>    Set the keywords for html output file. 

 

 -d<html description>   Set the descriptions for html output file. 

 

 -j<html javascript>     Set the javascript for html output file. 

 

 -i<icon file path>      Specify the icon path for exe output. 

 

 -w<window size>      Specify the size of exe window. 

                     Value could be: M,F, or some string like:800,600. 

                     (width is 800,height is 600). 

 

 

 Examples 1: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -thtml -c"Title" 

-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN 

 

 Examples 2: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico" 

-c"Title" -s"Float#Blues" -r"All" -q5 -R"GS" 

 

 Examples 3: 

 PTCMD -f"C:\input.pdf" -o"C:\outputfolder" -n"index" -tzip -c"Title" 

-s"Float#Blank" -r"All" -q5 -R"GS" -k"html key words"\ 

 

 

Return Code: 

1:  Success 

2:  Input file not found 

3:  Parameters are invalid 

4:  Failed to load PDF 

5:  Failed to import bookmarks 

6:  Failed to import links 

7:  Failed to import searchable information 

8:  Failed to save the output file. 
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License Agreements   

 

All copyrights to PDF to Flash Magazine Pro (the Software) are exclusively owned by 

Emagmaker.com. For more information, visit our website at www.emagmaker.com . 

 

Anyone may use this software but all the page-flipping eBooks generated will automatically 

have a demo watermark on the first page of them. To remove the limitation you must 

register. 

 

Once registered, the user is granted a non-exclusive license to use the Software on one 

computer (i.e. a single CPU) at a time. The registered Software may not be rented or leased, 

but may be permanently transferred, if the person receiving it agrees to terms of this 

license.  

 

The Software unregistered (trial) version may be freely distributed, provided the distribution 

package is not modified. No person or company may charge a fee for the distribution of the 

Software without written permission from the copyright holder.  

 

THE SOFTWARE IS DISTRIBUTED "AS IS". NO WARRANTY OF ANY KIND IS EXPRESSED OR 

IMPLIED. YOU USE AT YOUR OWN RISK. THE AUTHOR WILL NOT BE LIABLE FOR DATA LOSS, 

DAMAGES, LOSS OF PROFITS OR ANY OTHER KIND OF LOSS WHILE USING OR MISUSING THIS 

SOFTWARE. 

 

You may not use, copy, emulate, clone, rent, lease, sell, modify, decompile, disassemble, 

otherwise reverse engineer, or transfer the licensed Software, or any subset of the licensed 

Software, except as provided for in this agreement. Any such unauthorized use shall result in 

immediate and automatic termination of this license and may result in criminal and/or civil 

prosecution. 

 

All rights not expressly granted here are reserved by A-PDF Solution. 

 

Installing and using the Software signifies acceptance of these terms and conditions of the 

license. 

 

If you do not agree with the terms of this license you must remove the Software files from 

your storage devices and cease to use the product. 

  

 

http://www.emagmaker.com/
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How to Order 

 

Order Online (http://www.emagmaker.com/pdf-to-flash-magazine-pro/index.html) or Order 

Toll Free 1-877-353-7297 (When you order toll free just give the operator the product 

number of the product you would like). 

 

How to purchase online?  

 

1. Select a license type above, and click [Buy Now] 

 

2. Select the currency that you want to use. (You can also continue shopping) 

 

3. Fill billing information and select a payment method. (Your information is safe with us) 

 

4. Check the information you filled previously and click "Place Secure Order"  

 

Other Order Ways—With Phone/Mail/Fax/Check: 

 

If you are not comfortable ordering online with a credit card, you are welcome to choose an 

offline order option in the payment section of the order process. We accept mail, fax, wire, 

and PO (if applicable) ordering options in addition to ordering online. We also provide 

phone orders through our 24x7 order desk at 1-877-353-7297, or (952) 646-5331 for 

International Callers.  

 

Please note that all of the offline ordering options do have additional fees for processing. To 

place an order by mail, fax, wire, and PO (when applicable), use the online form and then 

choose one of these payment options found in the Payment Method section of the form. 

Once submitted online, the appropriate information will be provided to you in your web 

browser to send your payment to us offline. 

 

100% unconditional 30 Day Money Back Guarantee 

 

 

Want to custom the program or have other questions about purchase? 

Contact us at support@emagmaker.com . 

 

 

 

mailto:support@emagmaker.com
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Support 

You can easily search or browse our frequently asked questions, and learn tutorials about 

products, and get your registration code back. If you don't get a satisfying solution, please 

contact support team for help. 

 

1. Frequently Asked Questions 

You can find answers to questions about technique issues here: 

http://www.emagmaker.com/support 

 

2. Learn tutorial about PDF to Flash Magazine Pro 

We publish a video tutorial which shows you the easy procedure of dealing with PDF to Flash 

Magazine Pro, you can view this video to quickly handle the stunning tool:  

http://www.youtube.com/watch?feature=player_embedded&v=O0TAtCq3ceI  

 

3. Get lost license code 

Click here to look up the order » (http://www.regnow.com/cs/orderStatus) 

You can pull up a copy of your order by entering your email address. After you find your 

order, you may view its status, view details of your order (including the license key), and 

obtain the invoice.  

 

4. Contact Us  

If you have other questions or requirements, contact us directly through our support Email: 

support@emagmaker.com, we will respond you ASAP. 

 

 

 

 

 

 

http://www.youtube.com/watch?feature=player_embedded&v=O0TAtCq3ceI
http://www.regnow.com/cs/orderStatus


Professional convert PDF to Page-Flipping eBook Utility 
 

User Document 

Copyright 2010 by Emagmaker.com 
- 45 - 

 

 

 

 

 

 

http://emagmaker.com 
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